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Installing

Preliminary Planning

Preliminary planning for implementing any software application is important for achieving
the best setup results, the first time. We recommend that you take some time to review
this section to plan how your organization will be using Concordance Desktop so your
administrative tasks are minimized for initial setup and your long-term maintenance of the
application is streamlined into routine updates and adjustments, rather than reworking any
database design and system security later.

Preparing for Concordance Desktop

Preparing for Concordance Desktop on a Server

Preliminary planning for implementing any software application is important to achieve the
best set-up results, the first time. We recommend that you take some time to review this
section and plan how your organization will be using Concordance Desktop on a network
server. Planning ahead helps ensure that administrative tasks are minimized for initial setup
and your long-term maintenance of the application. When implemented properly, your
administrative tasks should then be streamlined into routine updates and adjustments,
rather than reworking any database design, server setup, and system security later.

Best practices for planning

Before installing Concordance Desktop on a network server, please review the best
practices below, to ensure your organization has reviewed all planning phases. 

Best practices for planning: Concordance Desktop Server

Data Hosting

Concordance Desktop server ASPs hosting client data should take
advantage of Microsoft® Active Directory® to first set up users
and then add those users to Concordance Desktop. Active
Directory includes password policies and organizational features
for managing users.

*Must set the Active Directory password to never expire

Large firms and organizations should also take advantage of
Active Directory and set up Concordance Desktop User
Management

*If using existing Active Directory, in Concordance Desktop, clear
the 'Logon required' check box on the Field rights tab in the
Security dialog box for each database
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Best practices for planning: Concordance Desktop Server

Smaller firms and organizations can use the Concordance
Desktop Admin Console to set up users and apply settings

Network Directory Setup

Ensure Concordance Desktop Server users have full network
access to the database directory

Have preset folder templates for each client and matter

Have a clear separation between billable and non-billable data

Receiving Data and Images

Verify that file formats are recognized by Concordance Desktop

Export databases to new Concordance Desktop databases to
update and verify existing structures to comply with your internal
guidelines

Database Design

Create default database structure templates for different types of
discovery

Implement field name conventions for consistency

Create an Admin tag folder

Verify that you used UNC paths in the Data Entry Attributes
dialog box (Edit > Validation)

Use UNC path with your hyperlinks

Create smaller databases and use concatenation

Use document-level text files

Add administration fields

Add EDITTRAIL and CREATEDATE fields

Server Setup and User Management

General Implement server and database firewalls when possible

Users Use the Concordance Desktop Admin Console, User Management,
and Microsoft Active Directory



Concordance Desktop 8

Best practices for planning: Concordance Desktop Server

Ensure Active Directory and Concordance Desktop user names
match, and do not include any special characters such as %, &, #,
etc. 

Implement your network password policies, and set Active
Directory passwords to never expire

Admin Console Setup user accounts

Set up administration user accounts 

Set up administration users alerts for emails. Alerts will be sent to
every administrator who has an email address entered in their
user account. 

Note that to send out notifications from the server, an e-mail client
(such as Microsoft Outlook) must be installed and setup on the
server. 

Managing Clients and Users

Inform users of training options, immediately

Create e-mail templates for users that include their logon
information and pertinent project or software instructions to get
them started

Always communicate turn-around times, as they change

Remember to educate, rather than dictate

Ongoing Maintenance

Schedule maintenance windows to ensure that all users are out
of the database and the database is taken offline 

Always take databases offline when loading any data or while
performing administrative work

Backups and Data Recovery

Always back up your FYI.db file

Ensure your internal guidelines are in place for back up and data
retrieval

Implement archiving and data destruction policies

Updating Considerations
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Best practices for planning: Concordance Desktop Server

Best Practice is to always be on the most recent version of
Concordance Desktop

Ensure your internal guidelines are in place for back up and data
retrieval

Quality Control

Have well-defined checklists and procedures in a centrally
available location

Ensure that hand-off processes are well-defined

Data hosting

There are two main scenarios that involve data hosting:

Concordance Server ASPs

Concordance Desktop Server ASPs provide setup, security, and maintenance services.
However, when speaking with Concordance Desktop Server ASPs, it is best practice to
confirm that they have certified Concordance Desktop and Concordance Desktop Server
members on staff to ensure your matter is setup properly and as soon as you need.

In-House Concordance Server Installations

For firms and organizations with the necessary technology infrastructure, data hosting
in-house allows for direct control of data and productions. Data hosting, requires a
mature organization with an experienced technical team that can overcome the liability
risks involved and can meet the financial investment required to ensure exceptional
hardware purchases and setup, dependable power to support services, and tight
physical security to protect data. 

Network directory setup

Most organizations have network directory design guidelines already in place to store
information in a consistent and logical manner. We have some recommendations for you to
consider while you review your own or to consider implementing for new cases:
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Folder Hierarchy and Naming Conventions

The following is an example of folder naming conventions and directory hierarchy for
storing documents, backup files, productions, etc. This is especially useful for Hosting
as it separates billable data from non-billable data. The Uploads folder gives a staging
area for quality control of data received from clients. From the Uploads folder, data can
then be moved to its appropriate final resting place. Moving is helpful for billing,
troubleshooting such as repairing Native File links if they are disrupted. Retaining a
folder template is useful when new data arrives or when moving a database to a new
directory location as this will help to keep organization consistent.

Databases for Billable versus Non-billable Tasks

Concordance Desktop Server ASPs hosting data for clients will have additional database
design needs to construct databases to manage billable versus non-billable tasks.
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Uploads for billable tasks:

· Images 

· Native files 

· Databases 

· Productions 

· Authority lists 

· Backups 

· Query files 

· Security 

Uploads for non-billable tasks:

· Staging 

· Load files 

· OCR files 

· Database administration documents 

Working with Concordance Desktop

When working with a Concordance Desktop database server, you want to ensure that you
have a strong understanding of Concordance Desktop and its viewer. There are various
aspects that must be taken into consideration during the preplanning phase.

Receiving Data

When you receive data from a client, data processing vendor, or third party, you should
always review all files and databases to ensure they have the proper formats for
Concordance Desktop.

We recommend having your OCR separated into individual document-level text files.
When importing these text files Concordance Desktop automatically overflows any text
that exceeds the 12 million character capacity of a paragraph field into the next
available field.

Database Design

Designing databases for reviewers and clients is a necessary planning phase that
ensures consistency in structure, naming conventions, user permissions, and more. The
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more forethought you apply to designing database templates, the easier it is for you
and other administrators to identify any irregularities that may occur.

Database design does differ slightly when created for review teams. We recommend
that you construct smaller databases containing fewer documents per database to
improve speed for tasks, like reindexing. Smaller databases also provide reviewers with
less down time when you are administrating maintenance updates.

Structuring Databases

Consistency is key when it comes to field naming conventions, types of fields included,
and the order of fields included in Concordance Desktop databases. When fields are the
same name and type, it is less confusing for reviewers and other administrators. With
naming convention guidelines in place, administrators can be assured that every
database has, for example, a BEGNO field as the beginning Bates number for records.

Checklist: Structuring Databases

Did you create default database structure templates for different types of
discovery?

In every template, did you include administration fields: TAGHISTORY, EDITTRAIL,
LOADDATE, CREATEDATE, PRODBEG1, PRODEND1, ADMIN fields, and so on?

Have you verified that all fields that need to be full-text searchable are designated
as paragraph fields in the database?

 

*Reviewers will then know that all fields in the Browse view that have a colon sign
are full-text searchable, and those with an equal sign are for relational searching.

Concatenation

Concatenation allows you to join up to 128 databases for the purpose of search and
review. When database are concatenated, clicking on the primary database opens all
databases listed in the concatenated file set for all reviewers each time.

When using concatenation only those databases that have been registered on the
Concordance Desktop server, are available in the list of databases that can be chosen
for concatenation. When sending the concatenated files to users via a shortcut (.fyi)
file, you only need to create a shortcut file for the primary database for distribution.
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The shortcut file will include all of the necessary links to all the databases in the
concatenated file set. Please beware that the size of concatenated file sets may cause
latency issues when reviewers view records and process updates.

System requirements

Please review the current system requirements for setup considerations and suggestions
for your processor and RAM. Review each section in advance before making expensive
hardware and network decisions that may not be in line with CloudNine recommendations.

When setting up permissions, make sure all users have full network access to each
database directory they need to work with.

Please keep informed of Concordance Desktop release updates and how they impact your
system, by checking our Concordance Desktop Release Notes.

System Requirements: Concordance Desktop Server

The minimum system requirements for Concordance Desktop Server are:

Hardware and
Software

Minimum Recommended

Processor (CPU)
Dual 3GHz Xeon® or Pentium
HT (hyper-threaded)
processors or higher

Dual 3GHz Xeon® or
Pentium HT (hyper-threaded)
processors or higher

Memory (RAM) 8GB 16GB

Hard Drive (Installation) 40GB of disk space or higher 40GB or disk space or higher

Supported Operating
Systems

(both 32- & 64-bit, all service
packs)

Microsoft® Windows Server
2016

Microsoft® Windows Server
2016

File Storage
(Images\Text\Native
Documents)

250GB 1TB

A disk caching, fault tolerant
RAID 1+0 array controller is
recommended for speed and
data integrity. 

Network Gigabit Gigabit

Software Required for
Proper Operation

· Microsoft Outlook 2013 or
higher (32 bit)

· .NET Framework 3.5 AND
4.7 or higher

·  Microsoft Outlook 2013 or
higher (32 bit)

· .NET Framework 3.5 AND
4.7 or higher
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· Internet Protocol v4 (IPv4) · Internet Protocol v4 (IPv4)
*IPv6 is not supported

In addition to the above, the server also requires two open ports in the firewall for
inbound and outbound traffic. By default, reviewers use Port 443 because it’s generally
already open on most firewalls and is typically used for SSL packets, so beware of
packet monitoring protocols. The default Admin Console Port is 10001 for
administrators, since it’s typically not used by other services.

Performance is directly affected by clock speed and can be improved by selecting
an SSD for your server.

Calculating User Capacity

User capacity of the Concordance Desktop Server is metered by the hardware. Based
on the number of users that need to be supported, you can combine multiple CPU
servers to have the proper user capacity available.

· A Pentium CPU supports 25 users. 

· A Xeon or Pentium Hyper Threaded (HT) CPU supports 50 users.

· Multiply CPU capacity for dual and quad CPU servers.

Additional Concordance Desktop Server considerations:

· Server capacity is also limited by bandwidth on your LAN and Internet connections
and by file server speed.

· The Concordance Desktop Server requires a minimum of 1 GB of available hard disk
space for installation of software, generated logs and temporary files, plus additional
space for databases.

· We recommend storing databases directly on the Concordance Desktop Server for
highest performance and system reliability.

· Indexing, reindexing, and packing may require extra disk space.

· Performance may be affected by indexing, overloading of available Internet or LAN
bandwidth, or in situations where databases are not stored directly on the
Concordance Desktop Server. 

· If performance is an issue, add processors with a higher clock speed, an SSD, or
additional bandwidth.

For additional information about system recommendations and software compatibility, see
System recommendations.

System Requirements: Concordance Desktop Workstation
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Hardware and
Software

Minimum Recommended

Processor (CPU)
AMD A6 or Intel i3 or Pentium
HT (hyper-threaded)
processors or higher

AMD Ryzen or Intel i7 or
Pentium HT (hyper-threaded)
processors or higher

Memory (RAM) 4GB 8GB

Hard Drive (Installation) 16GB available HD space 16GB available HD space

Supported Operating
Systems

(both 32- & 64-bit, all service
packs)

Microsoft® Windows 10 (32 or
64-bit)

Microsoft® Windows 10 (64-
bit)

File Storage
(Images\Text\Native
Documents)

N/A N/A

Network Gigabit Gigabit

Software Required for
Proper Operation

.NET Framework 3.5 AND 4.7
or higher, TLS 1.2, IPV4

.NET Framework 3.5 AND 4.7
or higher, TLS 1.2, IPV4

You cannot access Concordance Desktop databases on a machine that has IPV6
enabled.  If you plan to run Concordance Desktop mobile, you need to ensure that your
machine does not have IPV6 enabled.  If it does, you need to disable IPV6 and use
IPV4.  Note that by default, Windows 10 (and later) automatically enables IPV6.  For
more information regarding the disabling of IPV6, please see the Microsoft article on
IPV6 configuration guidance.

Server setup and user management

Your server infrastructure and set-up design are critical to ensuring that Concordance
Desktop works in a seamless fashion, and that data processing is running at optimal levels.
Planning your strategy in advance saves you frustration, time, and possibly even money in
the future. The steps you take now in carefully implementing the product, server database
locations, and network directories help ensure your success in using it.

You need to pre-plan:

· Port access and service protocols

· Server placement 

· Server firewalls and monitoring services

· User management

Plan your integration of Concordance Desktop server to ensure it coincides with your
organization’s network policies and procedures and re-examine them for how they impact
Concordance Desktop server requirements. If user restrictions are necessary at the
database level to prevent some users from seeing a database to select it, or to limit their
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field rights and menu access in specific databases, you may want to plan for using the
User Management feature to setup those restrictions on a database by database basis. 

For information about setting up you users, see About setting up and managing users.

For information about setting up database restrictions, see Restricting user rights to a
database. 

For information about user groups, see About clients, matters and user groups.

For information about clients and matters, see About clients, matters and user groups.

Identifying administrative tasks

Identifying which administrators need access to the Concordance Desktop Admin
Console is key to ensuring that ongoing maintenance gets performed.

Checklist: Identifying Administrative Tasks

Did you set up an administrator user ID and password in Microsoft Windows
Services for Concordance Desktop to access servers where data resides?

Do you know which administrators on your team need access to the Concordance
Desktop Admin Console?

*Each user should have an individual user name and password.

Additionally, have you identified which administrators on your team need access to
Concordance Desktop administrative menu items?

Have you determined if there are varying levels of rights being granted to
administrators?

Do you know which administrators will be in charge of Concordance Desktop
database processing (Zap, Pack, Index, Reindex), and for what clients, matters,
and databases in the Concordance Desktop Admin Console?

Have you decided which administrators should receive e-mail alerts when a
process fails to run, etc.?

Have you determined which administrators are responsible for ensuring that
packets are not dropped?

Did you decide which administrators are responsible for resolving severe errors?

External authentication or Concordance Desktop user management
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One of the primary distinctions to make in advance is whether you are using external
authentication to manage your users or are simply using Concordance Desktop user
management. The server can authenticate users using Microsoft Active Directory while
also allowing you to setup field and menu restrictions for each database with
Concordance Desktop user management.

· If you are installing the server on the DMZ (demilitarized zone), you should use the
external authentication to set up users, in addition to setting Concordance Desktop
user management in each database.

· If you are installing the server on a LAN (local area network), you can simply use
Concordance Desktop Admin Console to setup users and then use the User
Management feature to set field and menu restrictions on a database by database
basis. In Concordance Desktop, all  users are assigned access to all databases and
have full rights to fields and menus. 

For more information about authentication, see About setting up user authentication. 

Adding users and providing access

Most Concordance Desktop Server ASPs and organizations are managing hundreds of
users simultaneously and they all need access to multiple matters and databases in
remote locations. Designing a user matrix that identifies each user’s database access
needs may be helpful to reference when setting up and managing users.

Concordance Desktop provides two options for setting user access to databases; you
can use the User Management feature to grant users different read/write access to
fields and menus within a database, or use the Admin Console (under the Management
tab) to grant read/write access to fields and menus across all databases. User
management settings, user roles or groups, and user role templates can be modified
based on individual needs, and affect what a user can access in Concordance Desktop.
You can also control which databases and matters are viewable and accessible to each
user based on client and matter organization within the Admin Console (under the
Management tab). Understanding what key settings need to be retained in order for
users to access the server and underlying databases helps you minimize problem solving
later.

If your organization uses Concordance Desktop to add users, be sure to only use
single-byte characters when creating user names and passwords to be used in
Concordance Desktop.

For more information about user management, see About setting up user management. 

For more information about clients, matters and user groups, see About clients, matters
and user groups.

Synchronizing databases
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Synchronizing updates the user lists - adding new users and removing deleted users.

Databases can be synchronized automatically in the Admin Console by clicking the
Synchronize now button on the Management tab in the Admin Console. Jobs can also
be scheduled to synchronize databases.

A database administrator needs to be specified before a database can be
automatically synchronized.

Passwords

Concordance Desktop uses the authentication logon name to determine a user's
Concordance Desktop database rights, field rights, and menu settings. Check the
Concordance Desktop database in the Admin Console and add user names and rights as
needed.

Best Practices for new databases

If you need to restrict access on a database by database basis, first add the users in
the Admin Console and then restrict field-specific rights and limit their menu access
from the User Management screen. 

For more information about adding users to a Concordance Desktop database, see
Setting up users. 

Be sure to only use single-byte characters when creating user names, passwords, and
database names in Concordance Desktop.

The Concordance Desktop server does not support user, user group, database,
matter, and client names, or passwords that contain Unicode characters, such as
Chinese or Japanese characters. Currently, only single-byte characters, such as
English characters, are supported. 

Be sure not to use special characters when creating 

Concordance Desktop does not support the use of special characters, such as %,
&, #, etc. in user IDs, user groups, database names, matter names, and client
names. 

When adding domain users to Concordance Desktop, it is important to follow
these steps:

1. Add all of the domain user names to the Concordance Desktop database and assign
database rights and access.



Installing 19

For more information about adding users to a Concordance Desktop database, see
Setting up and managing users.

2. Add the users to the domain server.

3. Insert the domain users under the Users folder on the Management tab in the
Concordance Desktop Admin Console.  

For more information about inserting domain users, see Updating the Users list.

If both the LDAP and Auxiliary server options are set, both server names are
displayed when using the Insert Domain Users option.

Best practices for server setup

Concordance Desktop Server is server class software and requires a powerful, designated
server to ensure that performance is optimal. Some IT departments may try to host
Concordance Desktop Server on a virtual machine as opposed to a designated server in an
effort to save money without allocating enough system resources. Unlike Concordance
Desktop (where processing is performed on individual workstations), all processing for .FYI
users is done on the Concordance Desktop Server. When implementing Concordance
Desktop Server, we recommend that you invest in the best server your organization can
afford, that meets or exceeds what is stated in the system requirements. 

Concordance Desktop Server is not a web server and cannot work through a proxy
server. Concordance Desktop Server must have an open connection through a named
port. 

When planning your server setup, there are a few things to consider beforehand. We
recommend that you reference the Best Practices for Server Setup when planning your
server configuration. 

Please also refer to the Concordance Desktop Server recommendations in the System
Requirements.

Best Practices for Server Setup: Concordance Desktop Server

Concordance Desktop Server Security

Standard 24-hour Surveillance

Fingerprint/Retina scan access
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Best Practices for Server Setup: Concordance Desktop Server

Best Practice Hardware Firewall

Network/Server Monitoring

24-hour Surveillance

Fingerprint/Retina scan access

Concordance Desktop Server Backups

Standard Incremental secure backups

Best Practice Data Mirroring/Clustering

Disaster Recovery Plan

Offsite Data Recovery

Server Support

Required Staff CCSA 

CCFA 

Project Manager

Network Administrator

Technical Support

Best Practice 24/7 Technical Support

CCST

Paralegals

Print Job Clerks

Project Managers

Law Firm Experience, Previous Vendor Experience, and
EDD/Processing Experience

Database Administrators

Active Directory Administrators

Certified DBAs, Very Technically Savvy, Detail Oriented, and have
Network Administration Experience
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Best Practices for Server Setup: Concordance Desktop Server

Concordance Desktop Server Setup

Standard Be sure to have the recommended minimum hardware resources

Best Practice Create a separate Microsoft Windows account for Concordance
Desktop Server that has network rights to run services

Store active databases on the Concordance Desktop Server
itself or on a SAN or NAS server box that is attached to the
Concordance Desktop Server to eliminate as much network
latency as possible.

If you are using a SAN or NAS server box for databases, the
server should be on the same LAN, in the same location as the
Concordance Desktop Server, and connected to the

Concordance Desktop Server with Gigabit-speed Ethernet
switches and cables.

Be sure your Concordance Desktop Server is not on a Web
server.

Store the TIFF image files associated with your databases on the
Concordance Desktop Server or on a SAN or NAS server box that

is attached to the Concordance Desktop Server to eliminate as
much document and production latency as possible.

If you are using a SAN or NAS server box for TIFF image files, the
server should be on the same LAN, in the same location as the
Concordance Desktop Server, and connected to the

Concordance Desktop Server with Gigabit-speed Ethernet
switches and cables.

Concordance Desktop Shortcut (.fyi) File Setup

Standard Provide the shortcut (.fyi) file to the client to allow them greater
control over their data

Best Practice Make sure that clients/users are using the latest version of
Concordance Desktop.

We recommend that you do NOT allow access to the following
menu items:

· File > Modify

· File > Reindex

· File > Index

· File > Administration

· File > Begin Program

· File > Edit Program
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Best Practices for Server Setup: Concordance Desktop Server

· Edit > Validation

· Edit > Delete and undelete

Concordance Desktop server security

The Concordance Desktop server uses a variety of security methods to ensure data
integrity, security, and high performance. Please read this section carefully, prior to
implementing security for the computer you will be using as your Concordance Desktop
server. 

Concordance Server Connections

An installation of Concordance Desktop connects to the computer, registered as the
Concordance Desktop server, using an SSL encrypted connection. This connection is
fully compatible with firewalls that monitor and verify SSL traffic. Unlike a standard Web
server connection, the Concordance Desktop server connection is kept open for the
entire session for both efficiency and functionality. The connection is kept open to
send progress messages, to update interactive search results and progress meters, and
to perform other operations that would not be possible with repeated and unnecessary
connections and disconnections.

Encryption

Data passed between the Concordance Desktop server and clients is both compressed
and SSL encrypted for high speed and security. Concordance Desktop uses both RSA
public and private key encryption. All data is transmitted using RSA 128-bit encryption.
The initial handshake conversation is encrypted using 1024 bits. This is the same SSL
encryption used by web servers for tasks such as online banking. We recommend that
you install the server on SSL Port 443, as it is fully SSL compliant.

Ports

Administrators can log on to the Concordance Desktop Admin Console using an
administrator user name and password. Firewalls are not required, but can be used to
maintain security when exposing the Concordance Desktop server to public IP ranges.
Using firewalls determines which IP ranges are allowed access to the Concordance
Desktop server.
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Setting Port Addresses:

· End-user traffic for shortcut (.fyi) files via the Concordance Desktop server –
Default Port is 443 

· Administration traffic on the Concordance Desktop server via the Admin Console –
Default Port is 10001 

We recommend that you periodically check your ports to ensure they are open to
inbound/outbound traffic.

 For more information about modifying port addresses, see Adjusting port settings.

DMZ or LAN?

The Concordance Desktop server can reside on your LAN or in your DMZ as your data
security policy dictates.

· If you are using external authentication, user log-ons and passwords in
Concordance Desktop must be identical to the DMZ in order for reviewers to access
databases on the computer registered as the Concordance Desktop server.

· If you are only applying Concordance Desktop user management, we recommend
that you register the server license on a computer on your LAN because the DMZ
generally requires opening a connection from the server to the LAN, which can
create a security risk.

We also recommend using NAT (Network Address Translation) to open an inbound port
to the server, and setting the server to use SSL Port 443, as it is fully SSL compliant.

Authentication Types

Microsoft Windows NT, Microsoft Active Directory, and PDC secure login can be used by
Concordance Desktop, making user administration easy and fully integrated with your
existing network policies. Concordance Desktop will use NT, PDC, and Active Directory
authentication, passing all login and passwords to your existing domain server for
verification and enforcement of password policies including expiration, length, mix of
alphanumerics, and all other policy restrictions used by your organization.

Concordance Desktop with Active Directory, Windows NT, or PDC can be used to verify
users’ credentials. Logins are checked with Windows Security Controller. Setting this up
helps ensure conformation with password policies.

Supported Authentication Types

Internal Types Description
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Supported Authentication Types

Concordance
Desktop

Uses the .sec file to authenticate users. Highly recommend always
implementing a user login and password to connect.

External Types Description

External by Domain Allows for authentication against an NT Domain Controller (without
Active Directory).

External by NT
Server

Allows for authentication against a stand-alone server (Member
server).

External by Active
Directory LDAP

Uses the Microsoft Windows Active Directory to authenticate users.

Authentication by Lightweight Directory Access Protocol (Active
Directory).

For more information about external authentication and how it relates to users, see
About setting up user authentication.

Using Microsoft Active Directory

If you are using external authentication, you will need to first set up users in Active
Directory and then add the user's name in the Security Console of the Concordance
Desktop database, before specifying Concordance Desktop .FYI  users in the
Concordance Desktop Admin Console. When using external authentication, it is
important that user names match in the Active Directory and the Concordance Desktop
database.

We also recommend registering databases in the Concordance Desktop Admin Console
as a means of adding users to the Concordance Desktop Server. User accounts are
enabled in the Concordance Desktop Admin Console on the Management tab.

For more information about setting up users in the Active Directory refer to Microsoft's
web site and search on "active directory."

File Storage Considerations

File size and storage considerations are additional planning elements when setting up
the Concordance Desktop Server.

You need to ensure the following:

· The server hosting Concordance Desktop databases can access other servers easily

· That Concordance Desktop server can access files easily

· Databases and images are local to the Concordance Desktop server

· There are no latency issues arising from databases or image files that are too big
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You can choose to store databases and images in two ways:

· LAN  For this setup, we recommend you store databases and images on the same
server/computer that you have registered as the Concordance Desktop server, to
reduce any latency issues in accessing files.

· Network Accessible Storage  You can choose to store databases on one network
device and images on another, and have the Concordance Desktop server point to
these locations to access them. Latency differentiations are minor if database size
is kept smaller and all images are processed as single TIFs.

For more information about database design, see Preparing for Concordance Desktop.

Ongoing maintenance

As an administrator you are busy managing multiple cases, various software programs and
databases, and all in various network locations. We recommend that you take some
additional time to plan a maintenance schedule based on the following tasks and
processes, and any others that are distinct to your organization or client needs.

Typical database management for Concordance Desktop Server and companion
products include:

· Directory and sub-directory folder design to store multiple databases for multiple case
reviews within your organization

· Backup schedules for each client and matter, and each database, including multiple
database and/or concatenated databases

· Full index updates on databases performed during off hours (weekends or holidays) or
offline if multiple databases can be updated while staff continues work in other
databases

· Reindex updates when records are added or modified

· Loading data into Concordance Desktop databases offline

· Subsequent data and image loads

· Packing databases and dictionary files after removing records within the database.

· De-duplication

· Modifying or adding database fields, which then requires a full index

· Creating or removing users and adjusting security settings and permissions

· Tracking metrics

· Running productions

· Monitoring and extending user sessions

· Updating product versions in accordance with system requirements

· Archiving data according to your organization’s internal guidelines or client’s needs
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For more information about backups and data recovery, see About backups and data
recovery. 

For more information about automating tasks in the Concordance Desktop Admin Console,
see About scheduling jobs. 

Scheduling administrative tasks

Planning in advance what jobs need to be scheduled for ongoing maintenance helps you
determine the schedules you need to manage these tasks for multiple Concordance
Desktop databases and all your users and clients. By setting up a standard maintenance
schedule, you can inform your users in advance to ensure that they set up their review
times around these schedules. You want to make sure that all users are out of the
database and the database is taken offline when performing administrative tasks.

The Jobs tab in the Concordance Desktop Admin Console assists with management tasks,
like reindexing and packing. All scheduled tasks on the Jobs tab are processed on the
Concordance Desktop Server.

You can find your database indexing time by reviewing the Log tab in the
Concordance Desktop Admin Console.

For more information about automating tasks in the Concordance Desktop Admin Console,
see About scheduling jobs.

Exclusive Administrative Tasks

Some database management tasks require that all users are logged out of the
database. The administrator is the only user allowed in the database when the following
processes are occurring in Concordance Desktop:

· File > Modify 

· File > Index 

· File > Administration > Pack > Database 

· File > Administration > Zap 

· File > Administration > TRK Maintenance Tool 

The following database management tasks in Concordance Desktop do not require the
database to be taken offline, but they should be taken offline to ensure validity of all
data:

· File > Reindex

· File > Administration > Pack > Dictionary

· Documents > Import
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· Documents > Export

· Creating productions (Tools > Production > Production... or Tools > Production >
Native File Production)

·

Indexing and Reindexing Databases

Actively changed databases need frequent updating to keep the index and dictionary
entries current. An index is the exclusive process of creating the database dictionary
and index for the purpose of enabling full-text searching. A “reindex” simply updates the
existing database dictionary and its corresponding index. A reindex is not an exclusive
task. Concordance Desktop administrators are responsible for ensuring that all data is
reviewed and proper backups are made before indexing/reindexing the database with
updates. These processes are done from the File menu in Concordance Desktop, by
selecting Index or Reindex. 

One way to verify whether a database requires reindexing is to check the File menu in
Concordance Desktop. If there is a check mark next to Reindex on the File menu, then
the database dictionary is not current with additions or changes. You can also verify
reindexing status on the Databases task pane at the bottom of the Current Database
panel. If the active database dictionary needs updating, the panel displays Needs
Reindexing. Lastly, you can query on any documents that have changed under the
Search menu.

There will be times when you need to perform full index updates to include modifications
to the dictionary, stopwords list, and punctuation settings. This is an exclusive process
and only the Concordance Desktop database administrator can access the database at
the time during the process. To perform a full index, open the database, and on the File
menu, click Index. Reference the following Indexing and Reindexing Checklist to ensure
you have completed all necessary tasks prior to performing these processes.

Checklist: Indexing and Reindexing

Reindexing

Did you select the Allow exclusive indexing check box on the Indexing tab in the
Preferences dialog box (Tools > Preferences) in Concordance Desktop to prevent
reviewers from searching during a reindex?

Did you pack the dictionary to optimize reindexing speeds up to 6x?

Did you set up the ReindexingDaemon_V10.xx.cpl under the Windows Task
Scheduler to automate this task?

Indexing

Have you planned your indexing processes to run when it does not impact regular
work hours?
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Checklist: Indexing and Reindexing

Have you considered performing a full index for individual databases locally on
dedicated admin machines?

*Indexing and reindexing on a separate machine will not impact Concordance
Desktop Server performance.

Did you send a broadcast message to alert reviewers of when indexing will occur
and the timeframe for when the system may be available again?

*You can do this by sending broadcast announcements from the Connections tab
in the Concordance Desktop Admin Console.

Did you ensure that all reviewers are logged out of Concordance Desktop and .FYI
by checking the Status column on the Connections tab in the Concordance Desktop
Admin Console?

*Processing can take hours and impacts access to the system and work activity.
You can schedule these tasks on the Jobs tab in the Concordance Desktop Admin
Console.

Backups and data recovery

Most Concordance Desktop Server ASPs and large firms and organizations should already
have backup and data retrieval planning outlined and implemented, as well as disaster
recovery protocols. Determining backup schedules for Concordance Desktop Server
depends on the number of databases and users you have to manage. If you have
numerous users accessing databases and running tasks, you may want to consider
scheduling backups twice daily. If you only have a few databases with a handful of users
accessing them, you may be able to set backup schedules to once a week.

Do not perform live backups if you are using backup software that locks files, even
briefly. This has been known to cause read/write functions to the database files to
fail, and can cause file synchronization or corruption issues. Check with your IT group
and/or backup solution provider to verify that no file locking occurs before scheduling
any backups on Concordance Desktop Server and Concordance Desktop files that are
in use.

 

Be aware that anti-virus, firewall, and backup software can often interfere with
network traffic and the locking of files, and in effect could cause Concordance
Desktop Server software to crash.

For more information about backups and data recovery, see About backups and data
recovery.
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Updating considerations

Whether you are updating Concordance Desktop, or third-party products on the server
that hosts the Concordance Desktop server, you need to back up your FYI.db files first.

Often administrators run patches on their servers and reboot without stopping and
starting the Concordance Desktop services and backing up the FYI.db file. Doing so is a
common cause for file corruption of the FYI.db file – the very file you do not want to
rebuild. If you reboot the server while the Concordance Desktop services are still running,
it appears as a server crash to the services.

Updating Guidelines:

· Back up the Concordance Desktop server FYI.db File - Always back up your FYI.db
file before performing any updates to any products or services running on the
server/computer that hosts the Concordance Desktop server. 

For more information about backups, see About backups and data recovery.

· Concordance Desktop earlier versions  - Due to the new simplified installation and
the new database format, there is no upgrade process from a previous version of
Concordance Desktop, Concordance Desktop Viewer and FYI server to Concordance
Desktop. If you want to open existing databases in Concordance Desktop, you need to
migrate those databases to the new format. Once migrated, the databases can no
longer be opened in Concordance, they can only be opened in Concordance Desktop.
Therefore, we recommend backing up your databases prior to migrating them to
Concordance Desktop. Please see Migrating databases for more details. 

· Tagging - Before migrating existing Concordance 10.x databases to Concordance
Desktop,  ensure that any legacy issues with tagging are resolved in the databases, or
you will import those issues into Concordance Desktop. Once you migrate a database
for use in Concordance Desktop, the database can no longer be opened in the previous
version of Concordance, Concordance Desktop Viewer or Concordance Desktop server. 

Always back up the Concordance Desktop server FYI.db file before performing
updates to the server/computer, or updates to any third-party products on the
server that hosts the Concordance Desktop server. You need to shut down services
for Concordance Desktop while you perform updates, otherwise you risk corruption to
the FYI.db file, as the Concordance Desktop server reads a server reboot as a
system crash.

Moving existing Concordance Desktop databases to other servers

If you need to move existing Concordance Desktop databases to another server, and
need to ensure that all path information for those databases and imagebases are
preserved, we recommend that you hire a consultant.

You can consider creating an alias in your host file on your server, such as \
\myserver.1\. This would then redirect all paths to \\myserver.2\. See your local
network administrator for more information concerning your host files.
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Moving an existing Concordance 10.x database to another folder

If you plan to migrate an existing Concordance 10.x database to Concordance Desktop,
but also want to move it to another folder, first move the database to its new location
and open it in Concordance 10.x. Doing so ensures that the notes DCB is properly linked
to the parent DCB. Once these two steps are done, you can migrate the Concordance
10.x database to Concordance Desktop.

Moving imagebases

Concordance Desktop viewer

If you receive an error message stating that Concordance Desktop is unable to open
the corresponding document, you need to edit your folder paths. The folder path
listed in the message box is the path stored in the Concordance Desktop imagebase.
That path points to where your files are located, so the viewer can open and display
the document. You need to change the path to the directory location where your 
documents actually reside.  See, Renaming file paths and folders.

Use caution when resetting folder paths as there is no undo function and changes
are permanent. We recommend backing up the .cib file before performing this
process or other imagebase management tasks.

Licensing and Product Activation

While all functionality is installed with every installation of Concordance Desktop, it is the
licensing that determines what level of functionality is available to the users. Every
installation of Concordance Desktop is capable of being licensed as a server (on a
networked computer) or a stand-alone setup (on a single computer); and every
installation can be used as a work station for a Concordance Desktop Administrator or
Reviewer. 

There are five basic types of licenses; two are application licenses (server and mobile)
that designate the computer as a server for multiple users across a network, or as a
server for one user on their individual computer, and the remainder are user licenses that
when added to a server can be used to perform administrator or reviewer tasks. 

Application licenses

Application licenses are applied to only one computer, and allow for that computer to be
used as a Concordance Desktop database server. Once an application license is activated
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on a computer, it is tied to that computer and cannot be used or moved to another
computer. 

There are two different types of application licenses:

Application
license

Description and functionality

Server Used to activate server functionality on a networked server or
workstation computer. 

Mobile Used to activate server functionality, and enable all Concordance
Desktop user functionality on a single computer, for use by only one
user.  

Server license overview

A “Server” license is required to activate a Concordance Desktop installation as a
Concordance Desktop database server, on a Local Area Network (LAN) or Wide Area
Network (WAN). It is a "non-concurrent" license, meaning it can be used to activate only
one server. If you need to setup multiple Concordance Desktop database servers, you will
need a separate Server license for each computer you are going to use as a Concordance
Desktop server. 

A Concordance Desktop Server license is most beneficial for small to medium sized firms
that have a network environment, and/or the need for multiple users to work on the same
case. It allows for multiple users to open and work on the same database at the same
time. All Concordance Desktop databases created on a Server licensed computer are
"owned" by that server, meaning that all setup is stored on that server and all access to
those databases is controlled by the licenses added to that server. 

At least one server license must be purchased and activated on a computer (server
or workstation) in order to allow for Concordance Desktop databases to be created on
that computer. 

Mobile license overview

A “Mobile” license is required to activate Concordance Desktop server functionality, and
enable all user functionality on a single computer, for use by only one user. It is a “non-
concurrent” license, meaning it can be used to Activate and enable Concordance Desktop
functionality on only one computer. Usually, this is a computer that does not attach to a
network. 

A Mobile license is most beneficial for: 

· Small firms having only a few or less users who handle every aspect of the review
process themselves, and who have no need to share their databases with others in the
firm

· Firms that have no network LAN or WAN setup, or have no need to work with
Concordance Desktop databases on a network 
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· Firms that may or may not be on a network, but in which each user prefers to have all
information pertinent to their case on one computer; maybe a computer that they can
take with them to court

Users with a Mobile licensed Concordance Desktop installation still have the capability to
access databases on a network if they need to, but the databases they create on their
own computer stay on their computer, and are not readily accessible by others. Note that
at any point in time, a mobile licensed installation of Concordance Desktop can be
changed to a Concordance Desktop database server by simply purchasing and activating a
Server license on the current Mobile licensed computer, and of course attaching the
computer to a network. This makes it convenient for those who prefer to have their own
databases to work with and then after their case is over, would like to move the database
to an archive server for safe keeping. 

The main difference between a Server and Mobile license is that a Mobile license turns on
ALL functionality (Server, Administration and Full Reviewer) for a single user on a single
computer, whereas a Server license turns on only Server functionality on a network
computer (server or workstation). 

Distinctions between Mobile and Server installations:

 Mobile versus Server

Differences Mobile Server

RAM used for processing searches, indexing
databases

End-user machines Server

Set IP address restrictions for connections —

Load data

Reset Concordance Desktop password for
all user’s databases

Broadcast messages to online users

Kill user sessions —

Set Job Schedules

Track Usage History

Send Watchdog Notifications

Can take databases offline

Can accept connections from other users —
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 Mobile versus Server

A database can be opened by multiple users
at the same time 

—

User licenses

User licenses work a bit different than application licenses. They are used to access
different functionality in Concordance Desktop. A single User license, for the most part
can be used by multiple people, as long as they do not attempt to all use the same license
at the same time. User licenses are added to a Concordance Desktop database server
through the Administration Console, and are available for use by any user who has the
proper log in credentials to access the Concordance Desktop server and/or a database on
that server. 

There are three different types of user licenses:

User license Description and functionality

Administration Enables any user who has Concordance Desktop installed on their
computer, to perform administration functions as well as Full Reviewer
functions.

Full Reviewer Enables any user who has Concordance Desktop installed on their
computer, to perform Full Reviewer functions, as well as basic Data
Reviewer functions. 

Data Reviewer Enables any user who has Concordance Desktop installed on their
computer, to perform Data Reviewer functions. 

User licenses are based on availability, meaning how many licenses are available for a specific
type of user on a Concordance Desktop server, when that type of user attempts to log into
that Concordance Desktop server. If a license is not available, the user is granted the next
access level down from the one to which they are assigned on that server. For example, if an
administrative user attempts to log into a Concordance Desktop database server and there are
no Administration licenses available at that time, that user is granted access using the next
license down, which is a Full Reviewer license. If a Full Reviewer license isn't available at the
time, then they are granted access using the Data Reviewer license. If a Data Reviewer license
is not available at the time, then the user is unable to gain access to the server or it's
databases until a license is available. This holds true for all user licenses. 

Administrator license overview

An Administrator license provides access to the Concordance Desktop databases, and all
database and user administration features. Administrator users can create and maintain
Concordance Desktop databases, users, user settings, user groups, matters, and clients.  In
addition they have access to the same features as a Full Reviewer, meaning they can also
review documents in browse view or in the viewer (which displays a PDF image of the actual
document), markup documents in the viewer, search, categorize records, and create folders,
tags and issues. Administrator licenses are "concurrent" meaning, one license can be used by
multiple users, but not at the same time. 
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Full Reviewer license overview

A Full Reviewer license provides access to the Concordance Desktop databases for review
purposes. Full Reviewers can review documents in browse view or in the viewer (which

displays a PDF image of the actual document), markup documents in the viewer, search,
categorize records, and create folders, tags and issues. Full Reviewer licenses are

"concurrent" meaning, one license can be used by multiple users, but not at the same time.   

Data Reviewer license overview

A Data Reviewer license provides access to the Concordance Desktop databases for
review purposes. Data Reviewers can perform the same tasks as Full Reviewers, with the
exception of viewing and marking up documents in the viewer. They can review documents

(in browse view only), search , categorize records, and create folders, tags and issues.
Data Reviewer licenses are "concurrent" meaning, one license can be used by multiple users,
but not at the same time. 

Additional Recommendations

Using the server functionality on a network server, requires proficiency with Internet
addressing, ports, firewalls, and potentially with local area network (LAN) topologies and
security settings. These issues can be complex even for experts. Your IT staff or Internet
service providers are best suited to assist you with the security and network settings
specific to your company.

Concordance Desktop is optimized to perform at the highest levels; however, it cannot
overcome slow Internet connections, slow file servers, or simple overloading. The
Concordance Desktop Administration Console can monitor server performance to help
identify bottlenecks and server saturation. Interpreting the information and correcting
certain issues may require the assistance of an IT professional.

Network connection speed, network traffic, database and imagebase size, and other items
may be a factor when evaluating performance. Please review the following
recommendations for enhancing performance.

Indexing speed recommendations

We recommend giving Concordance Desktop as much memory as possible. Concordance
Desktop allocates memory to internal disk buffering during indexing. Any program that
decreases the amount of available memory, or performs background processing, could
severely impact indexing performance. The larger the database: the greater the
impact. 
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You can control the amount of cache, but be careful when allocating memory to the
cache. Windows has virtual memory that is stored on the hard drive when it is not
being used. If Concordance Desktop allocates a cache that forces too much swapping
to disk, indexing will actually run slower.

Indexing speed can be greatly improved by the following:

· Using a disk-caching hard disk controller

· Adding a faster hard disk

· Using a faster computer

· Indexing on a Windows NTFS formatted hard drive 

· Indexing individual databases on separate computers

The highest performance is obtained by combining some or all of these options. There
are many recommendations on this subject. All but one has the effect of lowering the
workstation’s disk activity. We also recommend indexing individual databases on
separate computers.

Lower workstation disk activity by: 

· Adding more cache RAM to your workstation and allocating this RAM to the Indexing
cache (up to 2GB maximum per ). 

· You should leave 128MB unallocated and available for the Microsoft Windows
operating system.

· Get a faster processor for the workstation

· Get a caching disk controller on the workstation

· Use a level 1+0 RAID array with your disk caching controller

Implementing these suggestions will result in a significant boost in indexing
performance. Index cache and processor speed have the greatest impact. 

Web Servers

The Concordance Desktop server does not require a Web server, such as Microsoft
Internet Information Server (IIS) or Apache. Concordance Desktop is a native software
application which runs directly on your server. It is optimized specifically for serving
Concordance Desktop and viewer data. It does not serve any other kind of data.
Remote users connect directly to the server from a Concordance Desktop installation.

The Concordance Desktop server is compatible with Web servers for data hosting, and
will run on a computer that is also running Web, FTP, mail, and other Internet servers.
However, we strongly recommend, for highest performance, that the server/computer
that you plan to register as a Concordance Desktop server be installed by itself on a
dedicated server/computer.

Memory and RAM
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All processing for Concordance Desktop shortcut (.fyi) files occurs on the Concordance
Desktop server. Concordance Desktop allows you to allocate a specific amount of RAM
for indexing databases. 

Concordance Desktop allows you to allocate a specific amount of memory for the
purpose of indexing databases. You can allocate up to 2GB per process in the Indexing
cache field on the Indexing tab in the Preferences (Tools > Preferences) dialog box in
Concordance Desktop. To determine the minimum amount of RAM you can allocate for
indexing take (Total RAM) – (O/S RAM).

For more information about calculating the indexing and dictionary cache, see Adjusting
indexing settings and  Adjusting dictionary cache settings.

Latency and Bandwidth

As administrators, how you monitor and manage SSL packets and set up your firewalls
affects reviewer bandwidth for sending and receiving information from your in-house
network to remote users. If users are experiencing latency issues, you will need to run
a trace route for any dropped packets and check your firewalls to see if there’s any
delay in sending and receiving information, and then fix any issues within your network.

The FYI.db File

All information from the Concordance Desktop Admin Console is stored in the FYI.db file,
which can be found in the same directory as the Concordance Desktop Program Data
folder  (ProgramData\CloudNine\Concordance Desktop). This file includes information
that is tracked for registered databases, users, licenses, settings, etc. The backup of
this file is critically important to ensure the security of the information that is being
stored.

Installing Concordance Desktop

Before installing Concordance Desktop

Here are some tips and information to consider prior to installing Concordance Desktop:

· You do not need to uninstall your existing Concordance, viewer and FYI Server
applications prior to installing Concordance Desktop. However, any databases created
in Concordance 10.x that you want to open in Concordance Desktop will need to be
migrated to the Concordance Desktop. Once a database has been migrated, you can
no longer open it in the previous Concordance and FYI Server applications. Therefore,
you may want to make a backup of the database prior to conversion. 
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· Concordance Desktop must be installed at its default location; you cannot use a
customized location.

· Databases created in Concordance 9.x and below will need to be converted to
Concordance 10.x databases (10.21 for E-Document databases) prior to migrating
them to Concordance Desktop. 

· Make sure that you regularly back up your server data and strongly caution users to
regularly back up their data on their workstations. Do not install Concordance Desktop
until your data has been backed up.

· Do not perform live backups if you are using backup software that locks files, even
briefly. Doing so can cause read/write functions to the database files to fail, and can
also cause file synchronization or corruption issues. Check with your IT group and/or
backup solution provider to verify that no file locking occurs before scheduling any
backups on Concordance Desktop databases. 

· Be aware that anti-virus, firewall, and backup software can often interfere with
network traffic and the locking of files, and in effect, could cause the Concordance
Desktop application to crash.

· The default install directory for the Concordance Desktop application data files is C:
\ProgramData\LexisNexis\Concordance Desktop

· If you choose to uninstall FYI Server, note that the CPL and Database folders
associated with that previous version are not removed. If you want to remove the
folders, make sure that you back up the folders first, and then manually delete them.

Before installing Concordance Desktop, check to ensure that the Microsoft .NET 3.5
and 4.0 Frameworks are installed and enabled. 

Before installing Concordance Desktop, be sure to review the following information about
Concordance Desktop licensing, system requirements, installation changes, and database
compatibilities.

Licensing

Application licenses are applied to only one computer, and allow for that computer to
be used as a Concordance Desktop database server. Once an application license is
activated on a computer, it is tied to that computer and cannot be used or moved to
another computer. There are two kinds of application licenses; server and mobile.

User licenses work a bit different than application licenses. They are used to access
different functionality in Concordance Desktop. A single User license, for the most part
can be used by multiple people, as long as they do not attempt to all use the same
license at the same time. User licenses are added to a Concordance Desktop database
server through the Administration Console, and are available for use by any user who
has the proper log in credentials to access the Concordance Desktop server and/or a
database on that server. 

For more information on licensing, see  About Licensing and Product Activation.



Concordance Desktop 38

For more information on obtaining licenses, please contact Concordance Desktop Sales by e-
mail at Sales@cloudnine.com.

Database compatibility

Due to the major database structure changes required by the Unicode Standard, all
databases need to be migrated to Concordance Desktop prior to opening those
databases in Concordance Desktop.

Since there is no backwards compatibility to older database versions in Concordance
Desktop, version 8.x and 9.x databases must first be converted to Concordance 10.x
format. When opening a 10.x database, regardless if it was a converted 8.x or 9.x
database or one created in 10.x, you are prompted to migrate it to Concordance
Desktop. If you choose not to migrate the database, it cannot be opened in
Concordance Desktop. 

For more information about migrating databases, see Migrating databases. 

Concordance Desktop databases are not compatible with Concordance 10.x or
lower, and any version of FYI Server and FYI Reviewer 

Installing Concordance Desktop

The Concordance Desktop application can be installed on any Windows 7, Window 10,
Windows Server 2008 R2, Windows Server 2012, or Windows Server 2012 R2 computer (for
networks, this could be a server or a workstation) that will either be used as a
Concordance Desktop database server, or as a reviewer's computer. To install, you simply
download the application setup file, install it on a computer or server, and then if you
want to use that installation as a Concordance Desktop database server, activate the
server functionality with a Server license. Reviewer computers do not have to be
activated. There Concordance Desktop functionality is controlled by the available user
licenses on the Concordance Desktop server, and their user account access level on that
server. On a single computer that is not on a network, the process is the same, except
that you have to activate the installation with a Mobile license, which activates the
installation as a Mobile, and enables all functionality for a single user on that computer. 

In a network environment, at least one computer should be designated as a Concordance
Desktop database server, and be activated with a Server license. All other Concordance
Desktop installations on the network (LAN or WAN) can then be used as reviewer
computers. Depending on the user licenses that get added to the Concordance Desktop
server, the users of the computers on which Concordance Desktop is installed, can open
and work with the databases on that server. For Concordance Desktop installation on a
single (non-networked) computer, a Mobile license must be activated in Concordance
Desktop, to enable all Concordance Desktop functionality for a single user on that
computer. 



Installing 39

Before installing Concordance Desktop, check to ensure that the Microsoft .NET 3.5
and 4.0 Frameworks are installed and enabled. 

Concordance Desktop must be installed at its default location on the C drive.

To install Concordance Desktop:

1. Download the installation file and save it to the computer, a network server, a flash
drive, or an external usb drive.

2. Open the folder where you downloaded and saved the install file.

3. Right-click on the Concordance Desktop_Install.exe file and select Run as
administrator. 

4. You are asked if you want to allow the program to makes changes, click Yes to
launch the installer. The welcome window opens.

5. Click Next.  The License Agreement window opens.
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6. If you would like to print the License Agreement, click the Print.  Click Yes to
continue with installation.  The Start Copying Files window opens. 



Installing 41

7. Click Next. The Ready to Install the Program window opens. 
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8. Click Install. The installation begins.  A progress bar displays the status.
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9. When the installation finishes, the Setup is now complete window opens. 
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10. Click Finish. 

If you just installed Concordance Desktop on a server or network computer you intend
to use as a Concordance Desktop database server, you need to activate the server
functionality on the computer using a Server license. If this installation was on a
network computer to be used by a reviewer, no activation is required. For more details
regarding activation and licensing, please see the "About Licensing and Activation"
topic.  

To set up a dedicated service account

It is best practice to use a dedicated service account, instead of a local system account, to
run Concordance Desktop Services to view data in the database, plan to use mapped drives
or work remotely. You will want to add and use a dedicated service account with
administrative rights to access the network directory where the databases reside. If you do
not have a valid service account set up that has rights to this directory structure, you will not
be able to connect to your images or native files if they are stored on a separate server.

The dedicated service account can also be the same account as the administrator account
used to access the Concordance Desktop Administration Console, or you can make separate
accounts for stronger security.
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To set up a dedicated service account, you need to set up a Microsoft Windows user account
with Log on as a Service rights. The dedicated service account should be set up before
installing Concordance Desktop. If you did not set up the dedicated service account before
installation, you can change the logon information for the Concordance Admin Server and
Concordance Server services in the Services Manager.

To change the Concordance Desktop Server service logon information in Services
Manager

1. Open the services.msc file.  

Opening the services.msc file opens the Services dialog box.

You can also open the Services dialog box from the Control Panel dialog box. From
the Start menu, click Control Panel, double-click Administrative Tools, and double-
click Services to open the Services dialog box.

2. Right-click Concordance Admin Server in the Name column and click Properties. 

Clicking Properties opens the Concordance Admin Properties (Local Computer) dialog

box.
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3. Click the Log On tab.

4. Click the This account option.

5. Add the Microsoft Windows user account with Log on as a Service rights to the This

account field.

6. Type the user account’s Microsoft Windows password in the Password and Confirm

password fields.

7. Click OK.

8. Repeat steps 2-8 for the Concordance Server service.

9. Stop and restart both the Concordance Admin Server and Concordance Server

services. 
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Activating/Resetting a Server or Mobile license

Application licenses are applied to only one computer, and allow for that computer to be
used as a Concordance Desktop database server. Once an application license is activated
on a computer, it is tied to that computer and cannot be used or moved to another
computer. 

There are two different types of application licenses:

Application
license

Description and functionality

Server Used to activate server functionality on a networked server or
workstation computer. 

Mobile Used to activate server functionality, and enable all Concordance
Desktop user functionality on a single computer, for use by only one
user.  

To activate a Server or Mobile license:

1. Open the email with your server or mobile license, and copy (CTRL + C) the license
key, including the semi-colon at the end.

2. Right-click on the Concordance Desktop icon on the desktop and select Run as
administrator.

3. In the User Account Control dialog box, click Yes. 

Concordance Desktop opens. 

4. From the Help menu, click Activate Concordance Desktop.

5. In the License Key field, paste (CTRL + Z) the license key.

6. Click Activate. 

7. A dialog opens asking for the port numbers for the server and the Admin Console.

The defaults are 10001 for the server and 443 for the Admin Console. If you have
FYI Server installed, you may need to change the defaults, as FYI Server also uses
10001 and 443 as the defaults for that products server and Administration Console.
Change the defaults if necessary. 

If you 'Cancel' the activation at this point in time, the Admin service is not
created. Your license key will be activated, but you will not be able to run the
Admin Console or perform administrative tasks on the Concordance Desktop server.
Run the Concordance Desktop installer and select "Repair" to remedy the issue. 

8. Click OK. 
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To reset a Server or Mobile license:

1. Right-click on the Concordance Desktop icon on your desktop and select Run as
administrator.

2. In the User Account Control dialog box, click Yes. 

Concordance Desktop opens. 

3. From the Help menu, click Activate Concordance Desktop.

Before proceeding to step 4, ensure that the Admin Console is not open in
Concordance Desktop. If it is left open during a reset, it can cause issues with
licensing. 

4. Click the Reset... button.

If you do not see the Reset... button, you did not select to run Concordance
Desktop as an administrator (see step 1). You will need to close the application and
start again. 

5. A dialog box opens asking if you are sure you want to reset now. Click Yes. 

The license key is reset.

Installing language packs

To display characters in Unicode within Concordance Desktop, the appropriate language
packs need to be installed on the computer. Please go to the Microsoft web site to find
out how to install language packs for your version of the Windows operating system. 

The Microsoft Windows Windows 7 operating system uses Language Interface Packs
(LIPs). These can be downloaded from the Windows Update Web site or the installation
media. Once you have installed at least one LIP, you can add or remove more LIPs from
the Control Panel.

To install language packs on a Windows 7 operating system:

1. In the Control Panel, click Change keyboards or other input methods.

2. Click the Keyboards and Languages tab.

3. Under Display Language, click Install/uninstall languages and follow the prompts.

For more information about installing LIPs, go to the Windows Help and How-to Web
page at: https://support.microsoft.com/en-us/help/14236/language-packs.
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Registry key locations

The registry settings are stored in the same places relative to the new key names:

Registry key locations for Concordance Desktop are:

· HKEY_CURRENT_USER\Software\LexisNexis\Concordance Desktop (32-bit)

· HKEY_LOCAL_MACHINE\Software\Wow6432Node\LexisNexis\Concordance
Desktop\Settings (64-bit)

Concordance Desktop also has a Registry value for the snapshot path:

· HKEY_CURRENT_USER\Software\LexisNexis\Concordance Desktop\Settings\AutoSave

It holds the path to the snapshot for the current user, which is:

<drive>:\Documents and Settings\<username>\My Documents\Concordance
Desktop\autosave.snp

Performing silent installs

When you need to install and activate Concordance Desktop on numerous machines, you
can save time by running silent installations of Concordance Desktop on each machine. 

Silent installations use a setup.iss InstallShield® Silent response file to run an installation.
Silent installations install applications without prompting you for input during the
installation.

To install Concordance Desktop using a silent installation, you will first need to create a
setup.iss file. This setup.iss file only needs to be created once. When you are creating the
setup.iss file, you will be running a normal Concordance Desktop installation on a machine
and will be recording each step and setting of the installation process for the setup.iss
file. After the setup.iss file is created, this file can be used any time you want to run a
silent Concordance Desktop installation on a machine.  

To create a setup.iss file for installing Concordance Desktop:

1. Click Start, and then click Run.

2. Type cmd in the Open field and click OK to open the cmd.exe command prompt.

3. Do one of the following:
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· Type the path to the Concordance Desktop_Install.exe file followed by -r and
press Enter. 

For example: w:\concordance desktop_install.exe -r

· Run the Concordance Desktop_Install.exe directly on the workstation and
complete all of the installation and activation steps.

When the installation is complete, the setup.iss file is created in the \WINDOWS
subdirectory. 

The setup.iss file contains a record of the actions you performed for each
installation dialog box.

Best practice is to store the setup.iss, and the Concordance Desktop installation
together in a network folder that you can access from each machine on which you
will be running a silent install.

4. Create a network folder and add the following files to the folder:

· setup.iss

· Concordance Desktop_Install.exe

To install Concordance Desktop using a setup.iss file:

1. Click Start, and then click Run.

2. Type cmd in the Open field and click OK to open the cmd.exe command prompt.

3. Type [path to the Concordance Desktop_Install.exe file] -s -f1[path to the
setup.iss files] and press Enter to silently install Concordance Desktop. 

For example: w:\concordance desktop_install.exe -s -f1w:\setup.iss

The -s parameter tells InstallShield that you are running a silent operation, and the
-f1 parameter indicates where the setup.iss file is located. Note that there is a
space between the -s and -f1 parameters, but there is no space between -f1 and
the path to the setup.iss file.

Silent installation programs do not display error or status messages, such as Setup
is now complete, during the installation. By default, silent installation status and
error information is recorded in the setup.log file. The setup.log file is automatically
created in the same directory where the setup.iss file is located.

If the setup completes, the setup.log file should contain the following information:

[InstallShield Silent]
Version=v7.00
File=Log File
[ResponseResult]
ResultCode=0
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[Application]
Name=Concordance Desktop
Company=CloudNine
Lang=0009|

Result codes indicate whether an installation was successful or there were errors
during the installation. A 0 in the ResultCode field indicates the installation was
successful.

For more information about the setup.log file, including a list of result codes and
their definitions, see the “Checking for Errors Using the Setup.log File” Help topic in
following Web site: http://helpnet.flexerasoftware.com

Click the Search button in the Flexera Software Web site and search for setup.log
to view the Help topic and other relevant Help topics.

Customizing the start-up view

In Concordance Desktop, there are four settings you can define to customize what you
will see when you open Concordance Desktop:

· Initial browse path

· Default database view

· Most recently used list

· Workspace tab display

To customize the Concordance start-up view

1. On the Tools menu, click Preferences to open the General tab in Preferences
dialog box.

2. In the Initial Browse Path field, click the ellipsis (...) button and browse to the
folder you want to be the initial folder that opens when browsing for a file or
opening a new database. 

For example, entering C:\Concordance Databases opens this folder when opening a
database in the Databases task pane.

3. In the Default view field, select Browse or Table.

The view you select is displayed when you open a database in Concordance
Desktop. 
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4. In the Number of MRU items field, type or scroll to the number of files to list in the
most recently used (MRU) file list. 

Your MRU list is displayed in the File menu and the Recent panel in the Databases
task pane. The maximum number of files you can display is 9.

If a user's MRU list in the File menu or Databases task pane is blank, your company
may have a policy preventing the user's computer from writing to the MRU registry
key:

HKEY_CURRENT_USER\Software\LexisNexis\Concordance Desktop\Recent File List 

By default, the Workspace tab is displayed and contains links to the CloudNine Web
site. You can customize your Workspace tab to display internal or external Web
pages simply by adding a link to an external HTML web page or to a locally stored
.HTM or .HTML file with information you’d like to publish for user reference.
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5. In the Workspace section, the Enable workspace check box is selected by
default. To continue displaying the Workspace tab in Concordance Desktop, leave
the Enable workspace check box selected. If you do not want to display the
Workspace tab, clear the check box.

6. If you want the Workspace tab settings to apply to all users in all databases, in
the Apply to field, choose <All databases, all users>. If you only want the
Workspace tab settings to only apply to the local user, choose <local user
only>. 

7. To add a link to an external HTML Web page, in the URL field, enter the Web site
URL. Be sure to include http:// or https:// in the URL. For example:
https://ediscovery.co/software/concordance/.

To add a link to an internal internal .HTM file located on your server, in the URL
field, enter the full UNC path. For example: J:\CloudNine\Internal_Links.htm OR \
\MyServer\MyFolder\myhtm.htm.

8. In the Attachments section, if the attachment fields were not set up during the
database creation process, to specify the fields to use with the Find Attachments
feature, do one of the following:

· To set a field to a range of attachments, select the Attach Range option, and
then select the field that contains the attachment range data. 

· To set up the beginning and ending attachment fields, select the Fields option,
and then from the Beg Attach and End Attach list select the fields that contain
the attachment data for the beginning attachment number and ending attachment
number.

When using the Find Attachments feature, it is best practice to setup the fields
as paragraph type fields to increase the performance and make sure to
index/reindex the databases. For more information about the Find Attachments
feature, see Finding attachments.

9. Click OK to save your changes. 

Your changes will not go into effect until you restart Concordance Desktop.

For more information about the other Concordance Desktop Preferences dialog box
settings, see Defining preferences.

Upgrading shortcut (.fyi) files

If you are using database shortcut (.fyi) files for users to connect to Concordance 10.x
databases that you will be migrating and registering on a Concordance Desktop server, the
shortcut (.fyi) files need to be recreated and redistributed to the users, after
migrating/registering the databases on the Concordance Desktop server. 
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To create a new shortcut (.fyi) file, see Working with shortcut (.fyi) files in the Answer
Center, or the Administrator's Guide. 
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